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Samsung Smart Display Licence Agreement  
 

By using this software you accept the following terms of this Licence Agreement. If you do not agree 
with these terms, you should not use the software and promptly return it for a refund.  

Ownership 
The developer retains ownership of this copy of the software. All rights not specifically granted in this 
agreement, including Copyrights are reserved by the developer. The software is licensed to you for use 
under the following conditions.  

Grant Of Licence   
This is not free software. 
You are licensed to copy, to install and use this product on a single PC Only. 

Registration 
This product must be registered before use. To register the product, please refer to the registration section 
of the Smart Display guide. 

Restrictions  
This software may not be copied.  
You may not translate, decompile, disassemble, reverse-engineer or otherwise reduce to a human-
perceivable form any part of this software. 
You may not create derivative works based on any part of it. 

Termination 
This licence and your right to use this software automatically terminate if you fail to comply with any 
provision of this agreement. 

Limited Warranty 
Samsung Telecoms Ltd will replace the software for you, at no cost, should you find any physical defects 
within the product as supplied, provided that you return the item, with proof of purchase, within 90 days 
of taking delivery of the software. 
Samsung Telecoms Ltd excludes any and all implied warranties, including warranties of merchantability 
and fitness for a particular purpose and limits your remedy to return the software to Samsung Telecoms 
Ltd for replacement. 
Samsung Telecoms Ltd has tested the software and reviewed the documentation. 
Samsung Telecoms Ltd makes no warranty of representation, either expressed or implied, with respect to 
this software or documentation, its quality, performance, merchantability or fitness for a particular 
purpose. As a result, this software and documentation are licensed to you “as is” and you, the licensee, are 
assuming the entire risk as to its quality and performance. In no event will Samsung Telecoms Ltd be 
liable for direct, indirect, special, incidental or consequential damages arising out of the use or inability to 
use the software or documentation, even if advised of the possibility of such damages. In particular, 
Samsung Telecoms Ltd shall have no liability for any data stored or processed with this software, 
including the costs of recovering such data. 

Governing Laws 
This Agreement shall be covered by the laws of the English Courts.  

General 
This Agreement contains the complete agreement between the parties with respect to the subject matter 
hereof, and supersedes all prior or contemporaneous agreements and understandings whether oral or 
written, express or implied. No Samsung Telecoms Ltd dealer, agent, or employee is authorised to make 
any modifications or additions to this Agreement. 
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     1 Introduction to Smart Display 

What is Smart Display? 
Smart Display is a quick and convenient “Screen Pop” call 
manager software application. It uses a simple PC screen 
interface that displays information about the incoming 
caller and allows calls to be handled efficiently.  
 
Smart Display is used in conjunction with the Samsung 
DCS Keysystem and with the most popular Personal 
Information Manager (PIM) applications to provide a fully 
integrated desktop display. Supported applications include 
MS Outlook, MS Schedule+ and GoldMine.  
 

What’s New in Version 2? 
Version 2 of Smart Display has been updated from the 
original version to have the ability to: 
 
• dial outgoing calls from a GoldMine record; 
• search all (or selected) phone numbers in a GoldMine 

record to pop a screen on an incoming call; 
• dial outgoing calls from the Smart Display window. 
 
All of these new features are fully explained in this guide. 
 
 
 



Introduction to Smart Display  
 

— Introduction — 2

What is Supplied? 
• A single floppy disk containing the installation file 

SETUP.EXE.  
• A certificate containing the software serial number and 

registration code. (The software serial number is also 
printed on the floppy disk label.) 

• A README.TXT file. 
• This Quick Guide. 
 

Your Requirements 
Your system should be running the appropriate software 
version: 
 

System Software Version 
DCS 4.2 or greater 
Compact I 4.2 or greater 
Compact II 2.3 or greater 

 
You will also need:  
 
• An ISDN telephone line connected to your Samsung 

DCS, Compact, or Compact II system (BRI or PRI) to 
provide caller line identification (CLI). 

• A PC with at least 16 Mb of RAM (32 Mb 
recommended) and 30Mb of hard disk space, running 
Microsoft Windows 95, 98 or NT.  

• A working version of Samsung's Smart Control V3.1 
application installed on your PC. 

• A Samsung Computer Telephone Module (CTM) 
connected to your PC. 
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• At least one PIM application selected from Microsoft 
Windows Outlook '97/'98, Schedule+ version 7.0a and 
GoldMine version 3.2 or 4.0. (Outlook is part of the 
Microsoft Office suite.) 

 
It is recommended that your PC is a Pentium 200 MHz or 
greater. 
 
It is assumed that you have a good working knowledge of 
both Microsoft Windows (95, 98 or NT) and the PIM 
application(s) you intend to use. Refer to the 
documentation supplied with these applications for more 
information.  
 
It is also assumed that you have set up your selected 
PIM(s) with records for each of your contacts. This guide 
provides details only for configuring your PIM(s) to work 
correctly with Smart Display and to set up the default 
dialler to make outgoing calls.  
 

What You Need to Do Now 
It is recommended that you follow these steps: 
 
1. Install Smart Display (Section 2). 
2. Configure Smart Display (Section 3). 
3. Depending on which PIM(s) you are using, read 

through the information in Sections 5 and 6 to find out 
what PIM configuration is required in order to work 
correctly with Smart Display.  

4. Start using Smart Display (Section 4). 
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Refer to the help screens and README.TXT file provided 
with Smart Display to obtain further information and 
guidance while running this application. If you have any 
problems, see Section 7, Trouble-Shooting.
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         2 Installing Smart Display 

First set up your hardware (PC, telephone keyset and 
CTM) as described in the Smart Control Version 3.1 User 
Guide, and ensure it is working correctly. Then: 
 
• Place the Smart Display floppy disk in the disk drive.  
• On the Windows desktop, click Start, then Run. 
• Type A:\SETUP.EXE and click OK. 
 
This will start the setup wizard to install Smart Display. 
Follow the dialogue boxes on the screen. Click the Next 
button on each box to continue to the next stage. At any 
time during the installation you can: 
- click Back to go back to the previous stage; 
- click Cancel to quit the setup. 
 
NOTE: The Readme file is displayed in a box during the initial part of 
the installation to give you the opportunity to view it. You can, 
however, choose to ignore this and read it later if required. 
 
The installation process creates a directory called 
SAMSUNG ELECTRONICS \ SMART DISPLAY in the Program 
Files directory, containing the Smart Display files.  
 
To activate Smart Display: 
 
• Click Start, Programs, Samsung Electronics, and select 

Samsung Smart Display. 
 
This displays the Smart Display Logon box. 
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   Figure 1 
 
 
The number in the Extension field should be the extension 
number of the keyset you are using. Click the OK button 
to confirm the number. If this is not the correct number, 
refer to Section 7, Trouble-Shooting, for advice. 
 
You now see the Smart Display box. This is the main call 
display box from which you control your incoming calls.  
 

      

Figure 2 
 
A dialogue box also appears, requesting you to register 
your copy of the software. This is described next. 
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Registration 
Click OK in the dialogue box. 
 
In the Smart Display box, click Help, then About. 
 
In the next box, click the Register button. You see the 
Registration box. 
 

Figure 3 
 
 
Type your registration code and serial number in the 
appropriate fields. The registration code is printed on the 
certificate supplied with the Smart Display installation 
disk. The serial number is printed on both the certificate 
and the disk label.  
 
NOTE: The registration code looks like 1234–5A6B. The serial 
number looks like 123–456–7890. 
 
Click the Register button. A message should appear 
saying, "Screenpop has now been registered". (If you 



Installing Smart Display  
 

— Installing — 8

receive an error message, first check you have typed the 
correct numbers and, if necessary, contact your dealer for 
advice.)  
 
Click OK in any remaining dialogue boxes, leaving the 
Smart Display box on the screen. Registration is now 
complete. 
 
Finally, click the Configuration menu and then select 
Preferences. In the Preferences box, click the User tab. 
    

Figure 4 
 
 
The number in the User field should be the same number 
entered in the Smart Display Logon box (Figure 1). If this 
is not the same number, refer to Section 7, Trouble-
Shooting, for advice.  
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Click the Apply and OK buttons to confirm the number. 
 
NOTE: During installation the system searches for installed databases 
(PIMs) and may pop a message asking you for the location of a 
database file. You can simply ignore this message and close the 
prompt if you wish to set up your database(s) at a later time. 

Readme Text File 
The Smart Display directory contains the README.TXT file 
which was displayed during the installation procedure. To 
view this file at any time, click Start, Programs, Samsung 
Electronics, Documents, Readme.
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    3 Configuring Smart Display 

You need to set up the application to work the way you 
prefer to work, and to tell it how to search your PIM(s) for 
information on your contacts. Use the Configuration menu 
in the Smart Display box to do this. 
 

Preferences 
To configure the way the application works, click the 
Configuration menu in the Smart Display box and select 
Preferences. You see the Preferences box. 
    

Figure 5 
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Application 
This page tells Smart Display how you want it to answer 
an incoming call and how the Smart Display box should 
appear on the screen. 
 
To automatically answer incoming calls, check (tick) the 
‘Auto Answer Calls’ option. When a call is received the 
keyset will answer the call and you can lift the handset or 
use the keyset speakerphone. Optionally, you can set the 
keyset to headset mode. 
 
To minimise the Smart Display box when there are no 
incoming or held calls, check the ‘Minimize When Not In 

 
 
To keep the Smart Display box permanently on top of any 
other applications you are running on your PC, check the 
‘Stay On Top Permanently’ option. 
 
NOTE: If the Minimize When Not In Use option is checked, you 
cannot select the Stay On Top Permanently option, and vice versa. 
 
‘My Calls’ option is set on (checked) by default. Do not 
change this setting. 
 
Database 
This page determines whether the information for the 
incoming caller, held in a PIM database, is to be popped 
up on the screen. You can also choose whether a call pops 
up when it is received or when it is answered. 
 
Click the Database tab. 
 



Configuring Smart Display  
 

— Configuring — 12

 
  Figure 6 
 
 
If you want a contact's details to pop up on screen for an 
incoming call, check the ‘With Contact Details’ option.  
 
To select whether the details are popped up when the call 
is received (rings your extension) or when the call is 
answered, check the corresponding option in the Popup 
When section. 
 
User 
This page shows the extension number of the connected 
keyset, to which calls are to be made. You should already 
have confirmed this number (see Section 2, Installing 
Smart Display). 
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Dial Out 
This page displays the digit that is required to access an 
outside line (usually 9). Click the Dial Out tab and enter 
the required digit in the External Call Access section. 
 

Figure 7 
 
 
It also shows the number of digits used for an internal 
extension (for example, 3). Enter the required number in 
the Internal Devices section. 

Databases 
Smart Display is set up to use a number of databases 
(referred to here as Personal Information Managers, or 
PIMs). Currently, these are: Outlook '97/'98, Schedule+ 
(version 7.0a) and GoldMine (version 3.2 or 4.0). You 
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have the option to use any or all of these databases, if they 
are available on your system.  
 
Click on the Configuration menu and select Databases. 
You see the Databases box. 

   Figure 8 
 
All three PIMs are listed. If a PIM is installed on your 
system, its status is indicated as 'Available'; otherwise it is 
marked 'Not Available'. The order in which the PIMs 
appears is also important: when a call is answered, Smart 
Display searches the first available PIM at the top of the 
list, then the second, and so on. Therefore, to speed up 
searches, you should ensure that your main PIM is at the 
top of the list.  
 
For example, in Figure 8, to set Outlook as the first to be 
searched you would select MS Outlook '97/'98 in the 
Database window and then click on the up arrow to the 
right of the window to put it first in the list. 
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Opening Databases and Phone Number Searches 
Smart Display automatically searches all available PIMs 
for contact numbers. A contact's record within a database 
may have more than one telephone number, e.g. business 
(Phone1), home (Phone2), mobile (Phone3) and so on. If 
Outlook or Schedule+ is used, all phone numbers for the 
contact are searched on an incoming call. However, for 
GoldMine, you need to configure which numbers are used 
for searches (see Before You Start Using Smart Display, 
below).  

Smart Control Application 

Smart Control must be installed on your system but does 
not need to be running in order for Smart Display to work.  
However, if you are running Smart Control, configure it so 
that it does not respond to incoming calls. Use the Call 
Notification Options in Smart Control to disable 
screenpops. (Refer to the Smart Control User Guide.) 

Before You Start Using Smart Display 

You will almost certainly need to configure your PIM(s) 
to work correctly with Smart Display. Read carefully 
Section 5, Configuring and Dialling With Outlook and 
Schedule+, and/or Section 6, Configuring and Dialling 
With GoldMine, before you attempt to start using Smart 
Display.    
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     4 Using Smart Display 

 Figure 9 
 

 
At the top of the Smart Display box is the menu bar 
containing five menus. Below this are five call control 
buttons: Answer, Clear, Hold, Drop/Answer, and Dial Out. 
These buttons only become active when you select an 
incoming call. The exception is the Dial Out button, which 
is active while the phone is on-hook.  
 
NOTE:  
1. The functions of the buttons are repeated in the Call Control 

menu and you therefore have the option of using the menu instead 
of the buttons. 

2. The call control buttons may be hidden from view by selecting 
the View menu and clicking the ‘Call Control Buttons’ option to 
remove the check mark. Check this option again if you want to 
view the buttons. 

 
Below the buttons is the My Calls window which displays 
brief details of an incoming or outgoing call (contact's 
number and call status). For incoming calls, the caller's 
number is used to search the appropriate database(s) for 
information on the caller. If configured to do so, Smart 
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Display will pop up a screen showing a full record for the 
contact (see Section 3, Configuring Smart Display). 
 
You have a choice in the way you control your calls—via 
the menu, using the screen buttons or using the keys on 
your keyset.  

Incoming Calls 
When a call is ringing at your keyset, the caller's number 
is displayed in the My Calls window as a 'Ringing' call. 
For example: 

 
Figure 10 

 
The selected database is then searched for this phone 
number, and if a match is found the name associated with 
this record is displayed in the My Calls Field. 
For example: 

Figure 11 



Using Smart Display 
 

— Using — 18

The caller's details are then popped up on the screen (if 
there is an existing record in the contact database and 
Smart Display is configured to pop a screen). The pop-up 
for this contact might look like this: 

Figure 12 

NOTE:  
1. When Schedule+ is opened for the first time it will pop the first 

contact record in your contact list (which may be incorrect for the 
incoming caller). To ensure the correct contact is subsequently 
popped, minimise the Schedule+ window after each call; do not 
close the window. 

2. When GoldMine is opened for the first time it asks you to enter a 
username and a password. When you have done this, it will 
subsequently pop contact records normally. If you close 
GoldMine at any stage, it will request these entries again when 
next opened. 

3. If there is a problem with the popup screen, make sure you have 
configured your PIM(s) correctly (see the relevant Section for 
configuring your PIM(s) in this guide). Also refer to Section 7, 
Trouble-Shooting. 

Answering a Call 
If you have configured Smart Display to automatically 
answer calls, the keyset's speakerphone is activated so you 



       Using Smart Display  
 

— Using — 19

can answer. Alternatively, lift the handset or use an 
optional headset.  
 
If Smart Display is not configured to automatically 
answer calls, answer the call by either double clicking on 
the call in the My Calls window or selecting the call and 
clicking the Answer button.  
 
The caller ID in the My Calls window changes colour 
from black to red and displays the call as 'Current'. For 
example: 

Figure 13 
 
    
Answering Multiple Calls 
If your keyset is configured to receive more than one call 
at a time, any new incoming call will also appear in the 
My Calls window. The new contact's record is also popped 
up (if available and configured to do so).  
 
If you are currently answering a call and wish to answer 
the new call, you have two options: either put the current 
call on hold and answer the new call, or drop (disconnect) 
the current call and answer the new call. This is described 
next. 
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NOTE:  
1. If you click on the new call in the My Calls window and click the 

Answer button while you are on a current call, the current call is 
automatically dropped (disconnected) and the new call is 
connected. 

2. A second call in the My Calls window will not be answered 
automatically if you are currently on a call. 

Putting a Call On Hold 
To put a call on hold, click the Hold button (or press the 
Hold key on your keyset). The call display colour changes 
from red to blue and displays the call as 'Held'.  
 
To take a call off hold, either double click the call display 
or select the call and click the Answer button. 

Dropping and Answering Calls 
If you have more than one call, you can hold the current 
call, as described above, and answer the new call as 
normal.  
 
Alternatively, you can drop (disconnect) the current call 
and automatically connect the new call. Click the 
Drop/Answer button to do this. The new call now becomes 
'Current'. 

Clearing a Call 
To clear (disconnect) a call, click on the Clear Call button 
or replace the handset. 
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Dialling from Smart Display 
It is possible to make outgoing calls directly from Smart 
Display by clicking the Dial Out button or by selecting the 
Dial Out option in the Call Control menu.  
    

Figure 14 
 

In the Dial Out box, enter the number to dial and click the 
Dial button. 
 
Alternatively, if you want to dial a previously used 
number, click on the arrow to the right of the number 
window and select the required number from the list. For 
example:  
    

Figure 15 
 

Click the Dial button to begin the call. 
 
NOTE:  
1. You do not need to enter a dialling access code prefix (such as 9) 

as this is added automatically. 
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2. The dialled number appears in green in the My Calls window of 
the Smart Display box.  When answered, the colour changes to 
red. 

 

Dialling from a PIM 
It is also possible to make outgoing calls directly from the 
PIM you are using. For details, refer to the relevant 
Section: 
 
Section 5, Configuring and Dialling With Outlook and 
Schedule+ 
Section 6, Configuring and Dialling With GoldMine. 
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 5 Configuring and Dialling With 
Outlook and Schedule+ 

You may need to set up Outlook and Schedule+ as 
described here. Because configuration of both applications 
is generally the same, Outlook is used as an example. Any 
differences are explained. You are also shown how to dial 
(make outgoing calls) directly from the PIM’s window. 
 
In the Smart Display box, select the Configuration menu, 
then Databases to display the Databases box (Figure 8). 
 

Configuring Phone Numbers 
 
Your databases are set up to allow for a variety of phone 
number formats. For example, click on Outlook in the 
Databases box and select the Properties button.  

   Figure 16 
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Dial Masks 
In the Properties box is a list of dial (telephone) masks. 
Dial masks tell Outlook in what format telephone numbers 
are to be searched when a call is received. By default 
(following the Microsoft requirement for Outlook 
dialling), Outlook is configured for three different UK 
number formats: 
 
 +44 (XXXXX) XXXXXX 
 +44 (XXXX) XXXXXXX 
and +44 (XXXX) XXXXXX  
 
(for example, +44 (01865) 887218). 
 
If these dial masks correspond to phone number formats in 
your database, you do not need to make any changes. 
However, you may have configured your database to have 
different dial numbers. For example, a contact may have a 
number such as (3) 9899 9277, corresponding to mask +44 
(X) XXXX XXXX. In this case you need to add the new 
dial mask. To do this: 

 
Click the Masks button to see the Mask Formats box and 
type the new mask format in the New Mask field.  

 
 
 
 
 
 



 Configuring Outlook & Schedule+ 

— Outlook & Schedule+ — 25

 

Figure 17 
 
Click the Add button. This puts the new mask in the 
Available field. To add the new mask to the list of active 
dial masks, select the mask and click the Add button. 
 
Remember that the order in which dial masks appear in the 
Active field defines the order in which they are searched. 
To speed up searches, use the arrow keys next to the field 
to put your preferred mask format at the top of the list 
(select the mask and click the arrows to move up/down). 
 
To remove a mask from the list, select the mask and click 
the Remove button.  
 
NOTE:   
Take care to put spaces and brackets in masks where necessary (see 
above examples). 
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Other Configuration Considerations 
 
Contact Directories 
With Outlook, your contact records are normally stored in 
the default Contacts directory (use the Folder List option 
in the View menu if you want to see the directory list). 
However, if your contacts are stored in another directory, 
you will need to inform Smart Display. This directory 
must not be a subdirectory of the Contacts directory. 
 
To configure a different directory, click on Outlook in the 
Databases box (Figure 8) and click the Properties button. 
In the Properties box (Figure 15) click the Browse button 
next to the Contact Database Name field. Select the 
directory that contains your contacts from the Contact 
Database Selection box and click OK. Click Apply and 
OK, and finally click OK to close the Databases box. 
 
If you are using Schedule+, Smart Display uses the default 
directory and there is no browse option. 
 
Network Directories 
Outlook can be configured to use a contacts folder on an 
NT Exchange Server. This contacts folder can then be 
shared with several Smart Display users. To configure a 
Network Folder, refer to the Outlook documentation.  
 
Configuring Schedule+ for Default Contacts View 
When opened, Schedule+ will present the first page for 
whichever tab is at the top of the Schedule+ window. You 
need, therefore, to ensure that this is the Contacts tab. To 
do this: 
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• Run Schedule+ and select the View menu. 
• Select Tab Gallery from the menu. 
• Highlight Contacts in the ‘Show these tabs’ window 

and use the Move Up button to place Contacts at the 
top of the list. Notice that the Contacts tab also moves 
to the top of the window. 

 

Dialling from Outlook and Schedule+ 

You can configure Outlook and Schedule+ to use the 
CTM as the default dialler. You can then automatically 
dial contacts from the Outlook or Schedule+ window. 
 
If you are using Outlook to set up the default dialler, this 
will also automatically configure Schedule+. 
Alternatively, you can set up the Schedule+ default dialler 
separately. Be aware, however, that if you set up the 
default dialler in Schedule+ only, this will not 
automatically configure Outlook for default dialling. 
 
Setting Up Autodialler for Outlook 
To set up the default dialler for Outlook (and for 
Schedule+ if you are also using this application):  
 
Click the Outlook icon on your desktop to open Outlook.  
 
Click the Contacts icon  
 
 
Click the Autodialler icon 
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You see the New Call box. 
    

Figure 18 
 
 
Click the Dialling Options button to see the Dialling 
Options box. 
 

Figure 19 
 
Select the device you want to use for outgoing calls in the 
Connect Using Line field. (This is the name set up in 
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Telephony Options in the Microsoft Windows Control 
Panel.) Click OK. 
 
Click the Close button.  
 
The Autodialler is now set up.  
 
Setting Up the Default Dialler for Schedule+ 
If you have not set up the default dialler in Outlook, you 
can do this for Schedule+ only. 
 
Open the Microsoft Windows Accessories program 
directory. 
 
Click the Phone Dialler icon  
 
 
In the Phone Dialler box, click Tools and select the 
Connect Using option. 
 
Select the device in the Line field and click OK. 
 
The default dialler is now set up. 
 
Making Outgoing Calls from Outlook 
To make an outgoing call to a selected contact from 
Outlook once Autodialler is set up: 
 
Select the contact to dial from the Outlook window and 
click the Autodialler icon     
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Select the number to dial in the Number field. 
 
Click the Start Call button. 
 
The number is dialled automatically. 
 
Making Outgoing Calls from Schedule+ 
To make an outgoing call to a selected contact from 
Schedule+ once the default dialler is set up: 
 
Click Contacts in the Schedule+ window and select the 
contact to dial. 
 
Click the dialler icon to the right of the phone number 
field in the bottom right-hand corner  
 
 
 
The number is dialled automatically. 
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   6 Configuring and Dialling 
With GoldMine 

You should set up GoldMine as described here. First, you 
must configure Smart Display to use GoldMine. Then you 
must configure GoldMine itself.  
 
You are also shown how to dial (make outgoing calls) 
directly from the GoldMine window. 
 

Configuring Smart Display 
In the Smart Display box, select the Configuration menu, 
then Databases to display the Databases box (Figure 8). 
 
Your databases are set up to allow for a variety of phone 
number formats. Click on GoldMine in the Databases box 
and then click the Properties button.  
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Figure 20 
 

In the Properties box there are four options: General, 
Telephone Masks, Dial Out and Contact Lookup. 
 
Dial Masks 
Dial (telephone) masks tell GoldMine in what format 
telephone numbers are to be searched when a call is 
received. Click the Telephone Masks tab to see the default 
masks. 
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Figure 21 
 

GoldMine is configured for a number of different UK 
number formats. For Smart Display, the recommended 
formats are: 
 
  XXXXX XXXXXX 
  XXXX XXXXXXX 
and  XXXX XXXXXX  
 
(for example, 01865 887218). 
 
If these dial masks correspond to phone number formats in 
your database, you do not need to make any changes. 
However, you may have configured your database to have 
different dial numbers. For example, a contact may have a 
number such as (3) 9899 9277, corresponding to mask  
(X) XXXX XXXX. In this case you need to add the new 
dial mask. To do this: 
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Click the Masks button to see the Mask Formats box and 
type the new mask format in the New Mask field.  

 
 
 

Figure 22 
 
Click the Add button. This puts the new mask in the 
Available field. To add the new mask to the list of active 
dial masks, select the mask and click the Add button. 
 
Remember that the order in which dial masks appear in the 
Active field defines the order in which they are searched. 
To speed up searches, use the arrow keys next to the field 
to put your preferred mask format at the top of the list 
(select the mask and click the arrows to move up/down). 
 
To remove a mask from the list, select the mask and click 
the Remove button.  
 
NOTE:  
1. Take care to put spaces in masks where necessary (see above 

examples). 
2. When setting up contact records for GoldMine itself, do not enter 

the code +44 in phone number fields. 
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Dial Out 
In order to be able to make outgoing calls from GoldMine, 
you must enable the Dial Out option. Click the Dial Out 
tab. 
 

Figure 23 
 
Check the Enabled box in the Dial Out Calls section. 
 
Now you need to tell Smart Display where to find the 
GoldMine User Ini file. This is the file called 
<USERNAME>.INI, where <USERNAME>  is the name you used 
when you installed GoldMine. The file is located in the 
main GoldMine directory. (In the example in Figure 22, 
the file is called MARTIN.INI and the GoldMine directory is 
D:\APPS.) Use the Browse button to select the file, which is 
then displayed in the ‘User Ini File’ window. If you do not 
know the file’s name, check with your system manager.  
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Contact Lookup 
This tells Smart Display how to search GoldMine when a 
call comes in, and how to display the search results.  
 
Click the Contact Lookup tab. 
 

Figure 24 
 
 
GoldMine allows you to enter up to three phone numbers 
(Phone1 – Phone3) for a contact in a record. You can also 
include a number of contacts within a single record—for 
example, if the record is for a company and you have 
several contacts within the company, the contacts can be 
placed in the Contacts folder for that record.  
 
You can therefore elect to have Smart Display search 
selected phone numbers (e.g. Phone1 and Phone2) and the 
Contacts folders to find the relevant information. Check 
the box(es) for the number(s) you want to search.  Check 



     Configuring GoldMine 

— GoldMine — 37

the Contacts box if you want to search the Contacts 
folders.  
 
Now check the relevant box in the Display Contact Details 
In section. Checking ‘New Window’ will display the 
relevant record in a separate window to the window that is 
active on the screen at the time the call comes in. 
Checking ‘Existing Window’ will replace the active 
window display with details for the new contact. 
 
If no record is found for an incoming call and you want a 
new record to be automatically created, check the ‘Create 
New Record’ box.   
   
You have now finished configuring Smart Display and 
need to configure GoldMine as follows.  
 
NOTE: For purposes of example it is assumed that you are using 
GoldMine V4.0. If you are using another version, screen displays may 
differ slightly from those described here. 
 

Configuring GoldMine 

Run GoldMine.  
 
In the GoldMine window, click the Edit menu and select 
Preferences. In the Preferences box, click the Modem tab. 
In the Dial Number Formatting section, check the ‘Dial 
numbers as entered’ box. 
 
Enter your Local Area Code for dialling. Then click the 
Dialing Properties button and check that the area code 
displayed in the Dialing Properties box is the same as the 
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one you entered. If it is incorrect, you will need to change 
it here (or in the Windows Control Panel). 
 
Return to the GoldMine main screen and click the Edit 
menu again. Select Record Properties and click the Phone 
Formatting tab. Check the ‘Non-USA Format’ box. 
 
You have now finished configuring GoldMine to work 
with Smart Display. 
 

Dialling from GoldMine 
You can configure GoldMine to use the CTM as the 
default dialler. It is then possible to dial outgoing calls 
directly from the GoldMine window. There are four 
different ways to do this depending on the phone number 
you want to dial, and each is described here. 
 
First, ensure that the main GoldMine window is 
displaying the ‘Basic’ toolbar containing the Dial 
icon.  
 
(To select the Basic toolbar, click the right mouse button 
on the GoldMine toolbar and select from the menu.) 
 
Option 1 (Dial Phone1 only) 
• Click the Record icon on the toolbar to display 

the required contact record. 
• Click the Dial icon to start the call using the 

number designated as Phone1. 
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Option 2a (Select number to dial) 
• Click the Record icon on the toolbar to display the 

required contact record. 
• Double click the required phone number (e.g. Phone2) 
 
Option 2b (Select number to dial) 
• Click the Record icon on the toolbar to display the 

required contact record. 
• Click Edit, then Dial Phone and select the number to 

dial (e.g. Dial Phone 3) 
 
Option 3 (Multiple contacts in a record) 
• Click the Record icon on the toolbar to display the 

record containing multiple contacts. 
• Click the Contacts tab. 
• Select the required contact and click the right mouse 

button. 
• Click Dial to start the call. 
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            7 Trouble-Shooting 

Should you encounter any problems while installing or 
running Smart Display, look through the following list of 
the most common faults and recommended actions.  Also 
refer to the help screens and Readme.txt file.  

It is important that you have configured your PIM(s) to 
work correctly with Smart Display. Make sure you have 
read carefully Section 5 and/or 6 before using Smart 
Display. If you still cannot correct the problem, or the 
problem is not listed, contact your dealer for advice. 

Installing Smart Display 
 
Problem Action 

Unable to select extension 
number in Smart Display Logon 
box (Figure 1) or Preferences 
box (Figure 5) 

Check that Smart Control V3.1 is 
installed and working correctly 
on your system 

Using Smart Display 
 
Problem Action 

No caller line identification in 
My Calls window 

Check that the incoming call is 
using an ISDN line and that your 
system is configured correctly 
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Problem Action 

No screen popup of contact 
details 

Make sure that: 

• a database has been selected; 

• a record exists for the 
contact; 

• dial masks are correct. 

Screen popup details in 
Schedule+ are incorrect for this 
contact 

When Schedule+ is opened for 
the first time it will pop the first 
contact record in your contact list 
(which may be incorrect for the 
incoming caller). To ensure the 
correct contact is subsequently 
popped, minimise the Schedule+ 
window after each call; do not 
close the window 

Smart Control pops a contact 
screen instead of your selected 
database 

Close Smart Control 

Or 

If you want to keep Smart 
Control running, configure the 
Call Notification Options to 
disable screenpops (see Smart 
Control User Guide) 

Dialling out causes the error 
message: 'An internal error 
occurred in the automatic phone 
dialler. Close the Dial Phone 
dialog box, and then open it 
again'  

Click OK on the error message 
box, then run Smart Control to 
load the application's driver 
software 

Close Smart Control again if you 
don't want it running. If you keep 
it running, configure the Call 
Notification Options to disable 
screenpops (see Smart Control 
User Guide) 
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Problem Action 

Dialling Out from the main 
screen or from Goldmine calls 
the DCS Operator instead of 
the selected number 

Check that the system dial prefix 
(Usually 9) is entered in the 
Configuration>Preferences>Dial 
Out Screen. 

Calling an internal extension 
from the main screen or from 
Goldmine makes an external 
call instead. 

Check that the number of internal 
digits (usually 3) is entered in the 
Configuration>Preferences>Dial 
Out screen. 
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